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Getting Started
Welcome to RioPort Audio Manager, the quick and easy way to manage and play music files on your 
computer or your portable player device.

This section introduces RioPort Audio Manager and shows you how to navigate its windows and dialog 
boxes. You’ll learn what RioPort Audio Manager can do for you. You’ll also learn where to go for more 
detailed, step-by-step instructions for working with RioPort Audio Manager, and how to find quick help as 
you work. 

What do you want to do?

About RioPort Audio Manager 
Navigate RioPort Audio Manager
Where to go from here 



About RioPort Audio Manager
RioPort Audio Manager lets you create, organize, and play song lists on your computer disk, and then 
transfer those song lists to your portable player device. You can add songs to your song database in three
different ways: you can record songs from a CD, download songs from the Web, or add song files which 
already exist on your hard drive. You can use the Search Hard Disks for Songs command on the File 
menu to scan your hard disks for song files, or you can drag song files directly from a Windows file list 
(like Windows Explorer) into RioPort Audio Manager. The songs are added to your song database so you 
can create your own song lists by selecting and organizing the songs. You can save these song lists as 
albums for future access. If you own a portable player device, you can connect it to your computer and 
transfer songs and albums from your database to the portable player device. 

You can also use RioPort Audio Manager to keep track of information about the songs and albums in your
database. Besides tracking the title and artist for a song or album, you can record details such as its 
genre, the year it was released, who wrote it, and notes about the song or album. Additionally, you can 
assign a rating or category to the song to allow you to organize your music more effectively. RioPort Audio
Manager allows you to completely personalize this information by providing six custom fields with which 
you can track any additional information which is not covered by another field.

What you can do with RioPort Audio Manager
· Add music to your song database by recording from an audio CD. See Copy from CD for instructions.

· Add music to your song database by downloading music from the Web. See Visit the Internet to get 
music for instructions.

· Create a song list. See Add songs to the song list for instructions.

· Create a custom album of selected songs. See Create an album for instructions.

· Play songs and albums from your database. See Play a song and Play an album for instructions.

· Assign categories to songs to help you organize your music files. See Organize your database with 
categories for instructions.

· Transfer selected songs to your portable player device. See Transfer music to a portable player 
device for instructions.

· Personalize your RioPort Audio Manager settings. See Set preferences for instructions.



Navigate RioPort Audio Manager
The illustration below shows the RioPort Audio Manager Playlist window. To see an description of any 
button or field, click it. 



Playlist tab
Click this button to access the Playlist, where you can listen to songs from your song and album 
databases, and organize songs into song lists.



Copy from CD tab
Click this button to record music from a CD into your song database.



Devices tab 
Click this button to transfer music files from your computer to your portable player device. 



RioPort tab

Click this tab to connect to the RioPort.com Web site, where you can learn more about RioPort products 
and services. The RioPort.com Web site also includes links to other sites where you can find, buy, and 
download music and related items.



Add Songs to the Song List button bar
Use this button bar to add songs to your current song list. Click the Select Songs button to select 
individual songs from your song database and add them to your current song list. Click the Select Albums 
button to add all of the songs from selected albums in your album database to your current song list. 



Song List
The Song List shows information about the songs in your current song list. The song title, artist, original 
album, and playing time is displayed for each song.



Organize the Song List button bar
Use this button bar to work with the songs in your Song List. Click the Clear List button to clear all of the 
songs from the current song list. Click the Save List as Album button to save your current song list as an 
album that you can easily access later. 

Click the Remove button (the trashcan icon) to remove the selected song from the list. Click the Up button
to move the highlighted song up one position in the Song List. Click the Down button to move the 
highlighted song down one position in the Song List.



Song Details box
This box shows details about the selected song, including its title, artist, genre, rating, year released, 
category, and other information. When you are working with the Playlist window, you can edit these 
details by right-clicking the song and selecting Edit Song. When you are working with the Copy from CD 
window, you can edit these details by clicking the Edit Titles button, highlighting the appropriate song, and
then clicking Review/Edit.



Player button bar
Use the Player button bar to control the playback of the songs in your current Song List. 

Click the Back button to skip to the song previous to the one that is currently playing. Click the Play button
to play the song. Click the Pause button to temporarily pause playing the song. To play the song again, 
click the Play or Pause button. Click the Stop button to stop playing the song. Click the Fwd button to skip
to the song after the one that is currently playing.

To move forward or backward in the song, drag the Song Position slider to the right or the left.

Drag the Volume control slider to the right to increase the volume. Drag it to the left to decrease the 
volume. 

To adjust the balance between the left and right speakers, drag the Stereo Balance slider to the right or 
the left.

By default, RioPort Audio Manager plays each song in the Song List once in the order they are listed. 
Click the Shuffle button to enable Random Play Mode, where RioPort Audio Manager plays each song in 
the Song List once in random order.

Click the Rep button to enable Continuous Play Mode, where RioPort Audio Manager plays each song in 
your Song List in order until you stop it. After it plays the last song in your Song List, it will start over from 
the beginning.

Click both the Shuffle button and the Rep button to continuously play through all of the songs in your 
Song List in a random order. With both modes enabled, RioPort Audio Manager continues to play until 
you stop it.



Small Player
Click this icon to transform RioPort Audio Manager into a Small Player which allows you to play the songs
in your current song list. 



Where to go from here
At this point, you may want to jump right in and start enjoying RioPort Audio Manager. We’ve done our 
best to provide you with a program that is powerful and easy-to-use. If you have questions about a 
specific button or field in the program, click the Help (“?”) button in the upper right corner of any window 
or dialog box and select the item in question. If you’re not sure where to go or how to complete a specific 
task while you’re using RioPort Audio Manager, choose Help Topics from the Help menu and search for 
the task in question. This online help file provides detailed instructions for all of the tasks you can perform 
with RioPort Audio Manager. You may also visit the RioPort.com Web site for the most up-to-date 
information on Frequently Asked Questions and product updates.

If you’d like additional information before you start using RioPort Audio Manager, you may continue with 
this online help file. To start using RioPort Audio Manager, close this window to return to the program. 

What do you want to do?

Work with the Playlist 
Copy from CD 
Transfer music to a portable player device
Visit the Internet to get music 
Learn about the menus 
Find more information on RioPort Audio Manager 



How to
This section provides step-by-step instructions for completing all the basic tasks in RioPort Audio 
Manager. Select a topic from the list below to receive instructions on using these features.

What do you want to do?

Work with the Playlist 
Copy from CD 
Transfer music to a portable player device
Visit the Internet to get music 
Learn about the menus 
Find more information on RioPort Audio Manager 



Work with the Playlist

In RioPort Audio Manager, all of your songs are stored in your song database. Similarly, your album 
records are stored in your album database. Most often, you play, organize, and edit these song and 
album records from the Playlist window. You can access the Playlist window by clicking the Playlist tab in 
the upper left part of the window. You can play songs from the Playlist window by adding them to your 
Song List. You control the playback with the Player controls in the lower right portion of the window. You 
can create custom albums by adding songs to the Song List, organizing the songs however you like, and 
then clicking the Save List as Album button. You can also edit song and album information by accessing 
your song and album records using the Select Songs and Select Albums buttons.

What do you want to do?

Add songs to the song database 
Add songs to the song list 
Create an album 
Play an album 
Play a song 
Edit song information 
Edit album information 
Use the Small Player 



Add songs to the song database
You can add songs to the song database in three ways: you can record them from an audio CD, 
download music files from the Web, or add songs that are already stored on your hard drive. 

What do you want to do?

Add songs from a CD to the song database 
Download songs from a Web site and add them to the song database 
Add songs from your hard drive to the song database 



Add songs from a CD to the song database
To add songs from a CD to the song database, you need to record those songs from the CD onto your 
hard drive. The recording process reads the selected track(s) from your CD and encodes it as a digital 
audio file. 

1. To record songs from an audio CD, insert your CD in your computer’s CD drive and then click 
the Copy from CD tab at the top of the window. 
The Copy from CD window opens and displays the tracks on your CD in the Track List. To download 
the CD title and artist and song name information from the CDDB Web site, you can click the Get 
Song Titles button. You then see the tracks on the CD in the Track List, including song title, song 
artist, and playing time.

2. Tag the song(s) you want to add to your song database.
To tag a song, click in the Tag column next to the song in the Track List. A check mark next to a song 
in this column indicates that the song is tagged. To tag all of the songs on the CD, click the Tag All 
button. To untag all tagged songs, click the Untag All button. To have RioPort Audio Manager reread 
the track information from the CD in the CD drive, click the Refresh button.

At the bottom of the Track List, RioPort Audio Manager calculates how many songs you have tagged 
and how much space is required on your hard drive to record them.

To edit the CD and individual song track information, click the Edit Titles button. You would typically 
use this option if the CDDB information is not available or is not correct for your CD.

For more information about the CDDB, see What is the CDDB?.

3. Click the Start Recording button.
The first time you record songs from a CD, you will be prompted to allow RioPort Audio Manager to 
configure itself to work most efficiently with your CD drive. If you choose not to do this, you must 
manually configure your CD drive on the Read CD tab of the Options dialog box. For more 
information on this, see the section regarding the Read CD tab in Set preferences

If RioPort Audio Manager is configured to work with your CD drive, it starts to record the selected 
tracks. The Status box displays the current progress of the recording process: the Status bar shows 
the recording progress of the current track, and the Overall Status bar shows the progress of all of the
tracks you selected. 

RioPort Audio Manager reads the selected tracks from your CD and encodes them as digital audio 
files on your hard drive. It adds the new song records to your song database. It also creates an album
record in your album database for this CD and links the new song records to that album.

For more information
See Copy from CD for more information on recording songs from an audio CD.

For more information about adjusting the RioPort Audio Manager options for the type of encoded digital 
sound files that are created, the storage location and file format of recorded song files on your hard drive, 
and communication with your CD drive, see the section regarding the Storage and Read CD tabs in Set 
preferences. 



Download songs from a Web site and add them to the song database
You can download digital audio files from the Internet. You can also have RioPort Audio Manager detect 
these files as they are added to your hard drive and they will be added to your song database. 

1. To download audio files from a Web site, click the RioPort button. 
RioPort Audio Manager uses your existing Internet connection to connect to the RioPort.com Web 
site, where you can take advantage of a variety of products, services, and information related to 
music on the Web, including the ability to search for, buy, and download music..

2. Download files from here or navigate from RioPort.com to other sites that offer digital audio 
downloads. 
The RioPort.com Web site provides you with a portal to the world of digital audio. This Web site offers
downloads (some of which are free, some of which may be purchased) from a variety of partners. You
can follow links from this Web site to many other locations on the Web where you may download 
digital audio files. If you know the Web address of a specific site that you would like to visit, you can 
type this in the Address field on this window and click the Enter key on your keyboard. The controls 
on this window (Back, Forward, Stop, and Home) work just like your Web browser.

3. To search for audio files on the Web, use one of the search engine links on the RioPort.com 
Web site. 
The RioPort.com portal offers several search engines that you can use to search for digital audio files 
on the Web. Most of these search engines allow you to search by artist, song title, and audio file type.

4. After you find an audio file that you want, download it to your hard drive. 
Typically, to download a file from the Internet, you click the link for the file that you want to download. 
Specify where you want to store the file on your hard drive, and your browser downloads the file. See 
the documentation for your Web browser for more information on downloading files from the Internet.

5. Add the downloaded song file to your song database, if you like.
To have RioPort Audio Manager automatically add the downloaded music file to the database, check 
the “Add song to database when song file is downloaded” box on the General tab in the Options 
dialog box. For more information on setting up your options, see the section regarding the General 
tab in Set preferences.



Add songs from your hard drive to the song database
If you have already downloaded some digital audio files from the Internet or recorded some songs from 
CDs using another digital audio encoder, you can add those songs to your RioPort Audio Manager song 
database.

1. To have RioPort Audio Manager scan your hard drive for song files and add them to your song
database, select Search Hard Disks for Songs from the File Menu. 
As RioPort Audio Manager scans your hard drive, you see the Progress window. Then the Review 
New Songs dialog box opens and allows you to review the songs you just added. 

2. To manually add songs to your song database, select Add Songs from the File Menu. 
You see the Add Songs dialog box. Navigate to the directory on your hard drive containing the song 
files that you would like to add. Click the Look in drop-down arrow to select a folder. Double-click a 
folder in the list box to open the folder and see its contents.

You can also drag and drop files to add them to your song database. See Step 4 below.

3. Select the files you want to add to the Playlist.
To select a single file, click it in the File list.

To select more than one file, hold down the Ctrl key on your keyboard and then click each file you 
want to add. 

4. Click the Open button.
This adds the selected song(s) to your song database. 

You can also add songs to your song database by dragging digital audio files from Windows Explorer 
and dropping them on RioPort Audio Manager. To do so, open both RioPort Audio Manager and 
Windows Explorer. In Windows Explorer, find the audio files that you want to add. Select the files or 
folders that you want, and drag them to RioPort Audio Manager. The song files will be added to your 
song database.

You see the Review New Songs dialog box.

5. Review the songs you have just added.
To preview the songs, use the Miniplayer controls under the Detail box. Click the Accept All button to 
mark all of the songs in the Review Song List as reviewed and remove them from this list. Highlight a 
song and click the Review/Edit button to review or edit song information. See Edit song information 
for complete instructions. Click the Review Later button to leave all of the songs in the list marked as 
not reviewed and close this dialog box. The songs have already been added to your database and 
their review status does not affect any other functions. 

Notes: You cannot add invalid audio files, such as those that are corrupt or incomplete, or songs from 
Temporary Internet Folders or your Windows Temp directory. You also cannot add songs which have been
previously added to your database. 

When you add songs and the Playlist window is open, the new songs will be added to your current song 
list.



Add songs to the song list
Once you have some songs in your song database, you are ready to create your own song lists on the 
Playlist window. After you create a song list, you can remove or reorganize the songs in that list and save 
the list as an album. You can also play the songs in your song list using the Player controls in the lower 
right part of the window.

1. To add individual songs to the song list on the Playlist window, click the Select Songs button. 
This window shows you a list of all of the songs in your song database, including the song title, artist, 
playing time, rating, and genre. 

You can sort the list of songs by clicking a column heading. For example, click the Artist column 
heading to sort the list alphabetically by artist.

You can also use the Find feature to help you locate a song in the list. To use Find, click the header of
the column that you want to search. The column sorts alphabetically and the Find field moves to the 
bottom of that column. Begin to type the name you want to find, and the highlight bar moves to the 
first item beginning with those letters or numbers. As you continue typing, the Find feature highlights 
the match closest to the text you type.

You can also edit song information by clicking the song and then clicking the Edit button. For more 
information on editing songs, see Edit song information.

2. Select the song(s) that you want to add to your current song list.
Tag a song that you want to add to your Song List by clicking in the Tag column next to that song. To 
tag all of the songs in the list, click the Tag All button. To untag all songs that are currently tagged, 
click the Untag All button.

3. Click the Add Items button.
When you have selected all of the songs that you want to add to your current song list, click the Add 
Items button to add the tagged songs to your current Song List. To disregard the tagged songs and 
close this dialog box without adding anything to your Song List, click the Done button.

4. To add all of the songs from selected album records to the song list on the Playlist window, 
click the Select Albums button.
You see the Select Albums dialog box, which shows a list of all of the album records stored in your 
album database. For each album, the list shows the album name, artist, rating, and genre. 

You can sort the list of albums by clicking a column heading. For example, click the Artist column 
heading to sort the list alphabetically by artist.

You can also use the Find feature to help you locate a album in the list. To use Find, click the header 
of the column that you want to search. The column sorts alphabetically and the Find field moves to 
the bottom of that column. Begin to type the name you want to find, and the highlight bar moves to the
first item beginning with those letters or numbers. As you continue typing, the Find feature highlights 
the match closest to the text you type.

You can also edit album information by clicking the album and then clicking the Edit button. For more 
information on editing albums, see Edit album information.

5. Select the albums from which you would like to add songs to your current song list.
To add all of the songs from an album to your current song list, tag the album by clicking in the Tag 
column next to that album. To tag all of the albums in the list, click the Tag All button. To untag all 
albums that are currently tagged, click the Untag All button.

6. Click the Add Items button.
When you have selected all of the albums from which you want to add songs to your current song list,
click the Add Items button to add all of the songs from the tagged albums to your current Song List. To
disregard the tagged albums and close this dialog box without adding anything to your Song List, click



the Done button.



Create an album
RioPort Audio Manager lets you create your own custom albums which you can easily access later. 
Create an album when you want to make party mixes or create song lists to send to your portable player 
device. Add the songs you want to the song list, organize the songs in the order you want, and save the 
list as an album.

1. On the Playlist window, click the Clear List button, if necessary.
If you want to create an album from scratch, click the Clear List button to start with a blank song list.

2. Add the songs you want on your custom album to the song list.
For complete instructions, see Add songs to the song list.

3. Organize the songs in the order you want.
RioPort Audio Manager plays the songs in the order they appear in the song list. By organizing the 
songs now and saving them as an album, you can access that album later to play the songs in this 
order. 

To move a song up in the list, highlight the song, and click the Up Arrow button. To move a song down
in the list, highlight the song, and click the Down Arrow button.

To remove a song from the current song list, click the Remove button (the trashcan icon). This only 
deletes the song from the current song list, not from your song database. If you change your mind 
and decide that you do want the song in your song list, add it to the list again.

4. Click the Save List as Album button.
The Add Album dialog box will open.

5. Enter an album description and any other information, and click Save/Close.
For complete instructions, see Edit album information. If you decide that you do not want to create 
this album, you can click the Cancel button to close this dialog box and return to the Playlist without 
creating this album.

Note: When you record tracks from a CD, RioPort Audio Manager creates an album record with those 
tracks. You cannot remove, rearrange, or add songs in an album record which is created when you record
from a CD. If you wanted to do so, clear your current song list, add the album to your song list, remove, 
rearrange, or add songs in the song list, and click the Save List as Album button and give your rewritten 
album a new name.

You can only submit information to the CDDB Web site for an original album. Rewritten or custom albums 
cannot be submitted. See the section regarding the CDDB tab in Set preferences for more information 
about submitting CDDB information.

For more information about the CDDB, see What is the CDDB?.



Play an album
After you record songs from a CD, add songs to your song database, or create a custom album, you can 
play the album from the Playlist window.

1. On the Playlist window, click the Clear List button, if necessary.
This removes any songs from your current song list.

2. Select the album that you want to hear.
Click the Select Albums button, tag the album that you want to hear, and click the Add Items button. 
See Steps 4-6 in Add songs to the song list for complete instructions.

3. You are now ready to play the songs in your song list.
By default, RioPort Audio Manager plays the songs in the order they appear in your song list. It plays 
each song once; after it plays the last song in the list, the playback stops. To start playback, click the 
Play button in the Player button bar.

4. Use the Player button bar controls to play the songs in your song list.
Back: Skip to the song previous to the one that is currently playing. 

Play: Play the current song, even if it’s paused.

Pause: Temporarily pause playing the song. 

Stop: Stop the song playback. 

Fwd: Skip to the song after the one that is currently playing.

Song Position: To move forward or backward in the song, drag the Song Position slider to the right 
or left.

Bal: Drag the Balance slider to the right to increase the sound delivered to the right speaker. Drag it 
to the left to increase the sound delivered to the left speaker.

Vol: Drag the Volume slider to the right to increase the volume. Drag it to the left to decrease the 
volume. 

Rep: Click this button to enable Continuous Play Mode, where RioPort Audio Manager plays the 
songs in your Song List in order until you stop it. After it plays the last song in your Song List, it starts 
over from the beginning.

Shuffle: Click this button to enable Random Play Mode, where RioPort Audio Manager plays all of the
songs in the Song List in random order.

Note: To continuously play all of the songs in your Song List in random order, click both the Rep and 
the Shuffle button. With both modes enabled, RioPort Audio Manager continues to play until you stop 
it.



Play a song
After you record songs from a CD, download songs from the Web, or add songs to your song database 
from your hard drive, you can play those songs from the Playlist window.

1. On the Playlist window, click the Clear List button, if necessary.
This will remove any other songs from your current song list.

2. Select the song that you would like to hear.
Click the Select Songs button, tag the song that you want to hear, and click the Add Items button. See
Steps 1-3 in Add songs to the song list for complete instructions.

3. Use the Player button bar controls to play the song(s) in your song list.
Back: Skip to the song previous to the one that is currently playing. 

Play: Play the current song, even if it’s paused.

Pause: Temporarily pause playing the song. 

Stop: Stop the song playback. 

Fwd: Skip to the song after the one that is currently playing.

Song Position: To move forward or backward in the song, drag the Song Position slider to the right 
or left.

Bal: Drag the Balance slider to the right to increase the sound delivered to the right speaker. Drag it 
to the left to increase the sound delivered to the left speaker.

Vol: Drag the Volume slider to the right to increase the volume. Drag it to the left to decrease the 
volume. 

Rep: Click this button to enable Continuous Play Mode, where RioPort Audio Manager plays the 
songs in your Song List in order until you stop it. After it plays the last song in your Song List, it starts 
over from the beginning.

Shuffle: Click this button to enable Random Play Mode, where RioPort Audio Manager plays all of the
songs in the Song List in random order.

Notes: To continuously play all of the songs in your Song List in random order, click both the Rep and
the Shuffle button. With both modes enabled, RioPort Audio Manager continues to play until you stop 
it.

You can also play tracks from a CD in your CD drive. For more information on this, see Copy from 
CD.



Edit song information
The song record for each song in your song database contains general song information, including the 
song’s title, artist, genre, and the year in which the song was released. It also contains advanced 
information about the encoder used to create the song file, the bit rate and sample rate used when the file
was created, and the source of the song. 

You can personalize your database by assigning a category to a song, rating the song on a scale of 1 to 
10, describing the sound quality of the song files, and using the custom fields to record information which 
is not covered by other data fields. RioPort completes many fields when it creates the song record (by 
recording, downloading, or adding songs from your hard drive). You can edit most of this information.

1. To edit the information for a song, click the Select Songs button on the Playlist window.
The Select Songs dialog box opens, listing all of the songs in your song database.

2. Click the song you want to edit, and then click the Edit button.
When you click a song, you see details for that song record in the Detail box to the right of the list.

After you click the Edit button, you see the Edit Song dialog box, which includes two tabs.

If you are having trouble locating the song that you would like to edit, RioPort Audio Manager    
includes a Find feature. See Find a song or album.

3. Click the Song tab to enter or edit general song information.
Title: In this field, you can record the title of this song.

Artist: In this field, you can record the name of the song’s artist. As you type, RioPort Audio Manager 
shows you the first item in the list of artists matching the letters you have typed. Click the drop-down 
arrow to select an artist you’ve already entered. 

Written By: You can record the name of the songwriter in this field.

Original Album: In this field, you can enter the name of the album on which the song originally 
appeared, or select one from the drop-down list.

Genre: Assign a musical genre to the song in this field. You may either type your own genre, or select
one from the drop-down list. As you type, RioPort Audio Manager shows you the first item in the list of
genres matching the text. 

Rating: To assign a numerical rating to the song, enter a number from 1-10 in this field. You can also 
click the up and down arrows to select a number. 

Original Track: In this field, enter the track number of this song on its original album. You can also 
click the up and down arrows to select a number. 

Year: In this field, record the year the song was released.

Version: If multiple versions of this song exist, you can enter the version number for this recording of 
the song in this field.

File Name: Normally, this field contains the path and file name of the song file to which this record is 
linked. However, if you have moved or deleted the song file, enter the new path and file name, or 
browse to the new file location for this song record by clicking on the ellipsis button (“…”) located to 
the right of this field.”

Miniplayer bar: Use the Miniplayer bar to preview the song that you are currently editing. Click the 
Play button to play the song. Click the Pause button to temporarily pause playing the song. To play 
the song again, click the Play or Pause button. Click the Stop button to stop playing the song. 

Drag the Volume control slider to the right to increase the volume. Drag it to the left to decrease the 
volume.

To move forward or backward in the song, drag the Song Position slider to the right or the left



Categories list: This list allows you to assign categories to the song you’re editing. Categories help 
you organize your music files. To assign a category to a song, click in the Tag column next to the 
appropriate category. To add, rename, or delete a category, click the Add Category button. See 
Organize your database with categories for more information on customizing your database with 
categories.

Notes: Use the Notes field to enter additional information you want to save in the song record not 
already recorded in a field. RioPort Audio Manager lets you connect to the Internet and navigate to a 
Web site by clicking the song artist’s name in the Detail box on the Playlist window. To link to a Web 
site, enter the URL (Web address) for that Web site as the first line of the Notes field in one of the 
following formats: http://(address” or !/(address). For example, enter 
http://www.myfavoriteband.com or !/www.myfavoriteband.com, but not www.myfavoriteband.com.

4. Click the Advanced tab to enter or edit advanced song information.
Encoder: In this field, select the encoder you used to encode the song. If the encoder you used is not
listed, enter it to add it to your list. If you recorded this song with RioPort Audio Manager, the Encoder 
is automatically entered as “RioPort.”

Bit Rate: This field shows the bit rate at which this song was recorded. The bit rate is the amount of 
digital information stored per second of audio. The higher the bit rate, the better the sound quality, but 
the larger the file size. You cannot manually change this entry.

Sample Rate: This field shows the rate at which this song was sampled. For CD-quality sound, the 
sample rate is 44100. Like the bit rate, the higher this value, the better the sound quality, but the 
larger the file size. You cannot manually change this entry.

Source: In this field, record the source from which you acquired the song, such as compact disc or 
downloaded, or select one from the drop-down list. 

Quality: To assign a quality rating to this song file, select Excellent, Good, Fair, or Poor from the drop-
down list. You can also type your own rating to add it to your list.

Custom 1-6: Use these fields to record information for which there is not already a data field. You can
edit a custom field name by selecting View from the menu bar, clicking Options, and then clicking the 
Custom tab. See the section regarding the Custom tab in Set preferences for more information about 
changing the custom field names.

5. To enter or edit information in the next song or previous song record in your song database, 
click the Next or Prev button.

6. Click Save/Close to save your changes and close the Edit Song dialog box. To discard your 
changes, click the Cancel button.

7. Click Done to close the Select Songs dialog box.



Edit album information
The album record for each album in your album database contains general album information, including 
the album’s title, artist, genre, and the year in which the song was released. You can also personalize 
your database by assigning a category to the album, rating the album on a scale of 1 to 10, and by using 
the custom fields to record information which is not covered by other data fields. RioPort completes many 
fields when it creates the song record (by recording, downloading, or adding songs from your hard drive). 
You can edit most of this album information.

1. To edit the information for an album, click the Select Albums button from the Playlist window.
The Select Albums dialog box opens, listing all of the albums in your album database.

2. Click the album that you want to edit, and then click the Edit button.
When you click an album, you see details for that song record in the Detail box to the right of the list.

After you click the Edit button, you see the Edit Album dialog box, which includes two tabs.

If you are having trouble locating the album that you would like to edit, RioPort Audio Manager 
includes a Find feature. See Find a song or album.

3. Click the Description tab to enter or edit the album information.
Album: In this field, enter the name of the album.

Artist: In this field, enter the name of the album’s artist. As you type, RioPort Audio Manager shows 
you the first item in the list of artists matching the letters you typed. Click the drop-down arrow to 
select an artist you’ve already entered. 

Rating: To assign a numerical rating to the album, enter a number from 1-10 in this field. You can also
click the up and down arrows to select a number. 

Genre: Assign a musical genre to the album in this field. You can either type your own genre, or 
select one from the drop-down list. As you type, RioPort Audio Manager shows you the first item in 
the list of genres matching the letters you typed. 

Source: In this field, record the source from which you acquired this album, or select one from the 
drop-down list. For example, if you recorded this album from a CD, select compact disc. As you type, 
RioPort Audio Manager shows you the first item in the list of sources matching the letters you typed.

Year: Use this field to record the year the album was released.

Custom 1-6: Use these fields to record information for which there is not already a data field. You can
edit a custom field name by selecting View from the menu bar, clicking Options, and then clicking the 
Custom tab. See the section regarding the Custom tab in Set preferences for more information about 
changing the custom field names.

Categories list: This list allows you to assign categories to the album you’re editing. Categories help 
you organize your music files. To assign a category to an album, click in the Tag column next to the 
appropriate category. To add, rename, or delete a category, click the Add Category button. See 
Organize your database with categories for complete instructions.

Notes: Use the Notes field to enter additional information you want to save in the song record not 
already recorded in a field.

4. Click the Track List tab to review or revise this album’s song list.
Custom albums and those created by downloading songs from the Web or adding songs from 
your hard drive

If this album record was created when you downloaded songs from the Web or when you added 
songs from your hard drive, or if it is a custom album you created from a song list, you can review or 
revise this album’s song list.

Use the Track List tab to edit the song order on the album’s song list. You can add songs, remove 



songs from the list, and change their order. This tab also displays detailed information about the 
highlighted song. The total number of songs on the album and the total playing time of the album is 
displayed at the bottom of the album song list. On this tab, you can also preview a song using the 
Miniplayer buttons.

Clear List: Click the Clear List button to clear all of the songs from the current Album Song List. 

Add Song: Click the Add Song button to access the Select Songs dialog box and select additional 
songs to add to the Album Song List.

Remove: Click the Remove button (the trashcan icon) to remove the highlighted song from the Album
Song List. 

Up/Down Arrow: Click the Up Arrow button to move the highlighted song up one position in the 
Album Song List. Click the Down Arrow button to move the highlighted song down one position in the 
Album Song List.

Miniplayer bar: Use the Miniplayer bar to preview the highlighted song in the Album Song List. Click 
the Play button to play the song. Click the Pause button to temporarily pause playing the song. To 
play the song again, either click the Play or Pause button. Click the Stop button to stop playing the 
song. 

Drag the Volume control slider to the right to increase the volume. Drag it to the left to decrease the 
volume.

To move forward or backward in the song, drag the Song Position slider to the right or the left.

Albums created when you recorded a CD

If you are editing an album record which was created when you recorded a CD, you can click the 
Track List tab to review and/or revise the individual song names in this album’s song list.

In this case, the Album Song List button bar has only one button, and the Track List tab includes the 
Submit to CDDB button at the bottom of the window.

Review/Edit: Use the Review/Edit button to edit the song information for the current song. For more 
information on editing song information, see Edit song information.

Submit to CDDB: Before you recorded the CD in the Copy from CD window, you probably accessed 
the CDDB Web site to obtain the CD’s title, artist, and track names. If the track information for this CD
was not in the CDDB database or was incorrect in the CDDB database, you can update CDDB’s 
information for this CD. 

To do so, edit the album’s information and then click the Submit to CDDB button. CDDB requires that 
you include your email address with your CD information submission, so you must enter a valid email 
address on the CDDB Options tab. (Click View on the menu bar, and then click Options.) 

You can only edit the album description information and the title and artist information for each 
individual song on the album. You cannot remove, rearrange, or add songs to the Album Song List.

For more information about the CDDB, see What is the CDDB?.

5. Click Save/Close to save your changes and close the Edit Album dialog box. To discard your 
changes, click the Cancel button.

6. Click Done to close the Select Albums dialog box.



Use the Small Player
You can transform RioPort Audio Manager into a Small Player which allows you to play the songs in your 
current song list. If you like, you can customize the Small Player dialog box using WinAmp skins.

1. To use the Small Player, click the Small Player icon at the far right of the RioPort Audio 
Manager navigation tabs.
The Small Player icon looks like two connected rectangles: one big, and one small.

You can also transform RioPort Audio Manager into the Small Player by selecting Small Player from 
the View menu or by pressing F8 on your keyboard.

The Small Player offers the same Player button bar controls that are available on the Playlist window. 
See Player bar for details.

2. Restore the Small Player to the full-size RioPort Audio Manager window.
You can restore the full-size window in four ways:

· Click the Big Player button in the upper right corner of the Small Player window.

· Click the Rio graphic in the upper left corner of the Small Player window and then click Go Big.

· Click the PL button, located to the right of the volume and balance controls.

· Click the Open button, which is located between the Fwd and Shuffle buttons. 

3. Change the color scheme, or “skin,” if you like.
The Small Player supports the use of color schemes or “skins” which have been created in the format
used by Nullsoft’s WinAmp software.

To change the skin, click the Rio graphic in the upper left corner of the Small Player window and then 
click Skins. Then navigate on your hard drive to the location of your WinAmp skin files, click one, and 
click the Open button. The Small Player should now be “wearing” the skin you selected. 

To return to the original RioPort Audio Manager color scheme, click the graphic in the upper left 
corner and select Restore Skin. This restores the original RioPort Audio Manager color scheme.



Find a song or album
You can use RioPort Audio Manager’s Find feature to find a song or album in the Select Songs or Select 
Albums dialog boxes.

1. In the Select Songs or Select Albums dialog box, click a column header to sort the list.
For example, if you’re looking for a song and you know the artist who performed the song, but not the
name of the song, click the Artist column header. Your list of songs or albums will now be sorted 
alphabetically by the artists’ names. At the bottom of the column you sorted, you will see the Find field
containing a blinking cursor. 

2. Start typing the name for which you are searching.
As you type, the highlight bar in the song or album list moves to the first item that matches what you 
typed.

For example, to find the artist “Superchunk”, first type “S”. The highlight bar moves to the first artist in
your list whose name begins with an “S”, such as “Sammy Davis, Jr.” When you type “u”, the 
highlight bar moves to the first artist in your list whose name begins with “Su”, such as “Sun Ra.” 
Continue typing “perc,” until the highlight bar moves to “Superchunk”. You see all of the songs by 
Superchunk in your database so you can locate the one you want.



Organize your database with categories
Use categories to organize your song and album databases. You can create categories based on musical 
genre, subject matter, or any other grouping that you find useful for organizing your music. For example, 
you could assign all the songs in your database without vocals to a category called Instrumentals. You 
can assign all of the songs in your database which are about New York City to a category called Songs 
About New York, and all of the songs in your database that are good for dancing at parties to a category 
called Dance Grooves. You can also assign each song or album record to multiple categories, so a song 
could be a member of both the Instrumentals and Dance Grooves categories. See Edit song information 
and Edit album information for more information about assigning categories when you are editing a song 
or album.

To assign a category when editing a song or album record:

1. When you’re editing song or album records, click the Song tab in the Edit Song dialog box, or 
the Description tab in the Edit Album dialog box.
In the lower left quarter of the dialog box, you see the Categories box. 

2. To assign the song or album that you are currently editing to a category, click in the Tag 
column next to the Category name.
You can assign a song or album to more than one category.

To add a new category to the Categories list:

1. When you’re editing a song or album record, click the Add Category button.
This button is located below the Categories box. When you click the Add Category button, the Edit 
Categories dialog box opens.

2. Click the Add button.
The New dialog box opens.

3. Enter the name for the new category in the Name field, and then click OK.
The new category now appears in the Category List.

If you do not want to add a new category, click Cancel to close this dialog box and return to the Edit 
Categories dialog box.

4. Click Close to close the Edit Categories dialog box and return to the Edit Song or Edit Album 
dialog box.

To rename a category:

1. When you’re editing a song or album record, click the Add Category button.
This button is located below the Categories box. When you click the Add Category button, the Edit 
Categories dialog box opens.

2. To rename a category, highlight the category in the Category List and click the Rename button.
The Rename Category dialog box opens.

3. Enter a new name for this category in the Name field, and click OK.
The category’s new name appears in the Category List, replacing the old name. All songs and albums
which were assigned to this category are updated with the new category name.

If you do not want to rename the category, click Cancel to close this dialog box and return to the Edit 
Categories dialog box.

4. Click Close to close the Edit Categories dialog box and return to the Edit Song or Edit Album 
dialog box.



To delete a category:

1. When you’re editing a song or album record, click the Add Category button.
This button is located below the Categories box. When you click the Add Category button, the Edit 
Categories dialog box opens.

2. To delete a category, highlight the category in the Category List and click the Delete button.
You see a message asking, “Are you sure?”.

4. Click the Yes button to delete the category, or click No to keep the category.
If you choose to delete the category, all songs and albums which were assigned to this category are 
updated to reflect that this category has been deleted. Any records which are not assigned to any 
other category will be assigned to the Unfiled category.

5. Click Close to close the Edit Categories dialog box and return to the Edit Song or Edit Album 
dialog box.



Copy from CD
In RioPort Audio Manager, you can record songs from your audio CDs. The songs are recorded as digital 
audio files and stored on your hard drive. Use the Copy from CD tab to record songs from CDs to your 
hard drive.

What do you want to do?

Record and play songs from a CD
Get song titles 
Edit Titles 
Select the songs you want to record
Start recording 
Stop recording 



Record and play songs from a CD
1. Insert the CD into your CD drive and display the CD and track information in the Copy from CD

Track List.
Before you start recording from a CD, you can retrieve the CD’s title, artist, and track titles from the 
CDDB Web site on the Internet (see Get song titles). If your CD is not found there, you can manually 
enter the CD and track information. (See Edit Titles).

2. Tag the songs that you want to record from this CD.
See Select the songs you want to record for more information.

3. Click the Start Recording button.
The first time that you try to record songs from a CD, you are prompted to allow RioPort Audio 
Manager to configure itself to work efficiently with your CD drive. If you choose not to do this, you 
must manually configure your CD drive on the Read CD tab of the Options dialog box. For more 
information on this, see the section on the Read CD tab in Set preferences

Click the Start Recording button to start the recording process. As the songs are recorded, a Status 
box shows you the recording progress of the current track, and of all of the tracks which you have 
selected to record. See Start recording for more information.

If you want to stop the recording, click the Stop Recording button (see Stop recording).

During the recording, you can use other parts of the RioPort Audio Manager program, or you can 
work in other programs without interrupting the recording process.

4. When the recording is complete, the songs will be recorded on your hard drive and added to 
your song database.

You can set a variety of options for recording from CDs, including storage locations, file format, file type 
and encoding rate, and which CD drive to use. For more information about these options, see the 
sections concerning the Storage and Read CD tabs in Set preferences.

To play tracks from your CD:

Before you record any tracks from a CD, listen to the ones you want to record. To play tracks from the 
Copy from CD window, you use the shortcut menu in the Track List.

1. Insert the CD into your CD drive and display the CD and track information in the Copy from CD
Track List.

2. In the Track List, right-click a track.
Point to a track and then click the right mouse button to see a shortcut menu with the following 
options:

Play Previous CD Track: Select this option to play the track that is previous to the one which is 
currently highlighted. 

Play Selected CD Track: Select this option to play the track that is currently highlighted.

Pause CD Play: Select this option to pause the currently playing track. To play the track again, right-
click and select this option again. 

Stop CD Playing: Select this option to stop playback from the CD.

Play Next CD Track: Select this option to play the track that is after the one which is currently 
highlighted.

3. If you navigate to another window in RioPort Audio Manager, or if you click the Start 
Recording button, the CD track stops playing.



Get song titles
1. Insert a CD in your CD drive. 

If you have more than one CD drive, you can specify which one RioPort Audio Manager uses. For 
more information, see the section concerning the Read CD tab in Set preferences.

When your CD is detected, RioPort Audio Manager reads the information from the CD. 

2. RioPort Audio Manager accesses the CDDB Web site via your Internet connection.
Depending on the options you have set in the CDDB tab on the Options dialog box (for more 
information about this, see the section concerning the CDDB tab in Set preferences), RioPort Audio 
Manager accesses the CDDB Web site or it asks you whether you want to do this.

If you allow the program to access the CDDB Web site on the Internet, it searches for CD information 
matching the CD in your CD drive. One of three things happens:

· In most cases, RioPort Audio Manager finds a perfect match and displays the CD title and the 
individual track titles in the Copy from CD Track List. 

· In some instances, RioPort Audio Manager cannot find an exact match, and asks you to select 
from among the closest matches. It then displays that information in the Track List. 

· In rare situations, CDDB will not contain a match for your CD. RioPort Audio Manager then lists 
the tracks from your CD with the track numbers. You can enter the information yourself by clicking
the Edit Titles button and then submitting the corrected information to CDDB. For more 
information, see Edit Titles.

For more information about the CDDB, see What is the CDDB?.



Select the songs you want to record
After you copy songs from a CD, the Copy from CD Track List shows the title of the audio CD in your CD 
drive, and the title, artist, and length of each track on the CD. 

To select songs you want to record:

· Tag the tracks you want to record on your hard drive.
Use the button bar at the bottom of the Track List to work with the items in the Track List. Click the 
Refresh button to read the information from the CD in your CD drive again. Click the Tag All button to 
tag all of the tracks in the list. Click the Untag All button to clear the checks in the Tag column for all of
the tracks in the list.

The status line at the bottom of the Track List indicates the number of tracks you’ve tagged, and the 
space required to record the tagged tracks onto your hard drive.



Start recording
Once you have selected the songs you want to record from a CD, you are ready to start recording. 

· Click the Start Recording button. 
During the recording process, the Copy from CD Track List will be disabled.

The first time that you try to record songs from a CD, you are prompted to allow RioPort Audio 
Manager to configure itself to work efficiently with your CD drive. If you choose not to do this, you 
must manually configure your CD drive on the Read CD tab of the Options dialog box. For more 
information on this, see the section on the Read CD tab in Set preferences

Click the Start Recording button to start the recording process. As the songs are recorded, a Status 
box shows you the recording progress of the current track, and of all of the tracks which you have 
selected to record. See Start recording for more information.

If you want to stop the recording, click the Stop Recording button (see Stop recording).

During the recording, you can use other parts of the RioPort Audio Manager program, or you can 
work in other programs without interrupting the recording process.

When the recording is complete, a dialog box informs you that the recording was finished successfully 
and tells you how many songs were recorded.



Edit Titles
Before or after recording songs from the CD in your CD drive, you can edit the album and track 
information for that CD.

1. On the Copy from CD window, click the Edit Titles button.
This opens the Review Album dialog box, which contains two tabs.

2. Click the Description tab to enter or edit general album information.
Album: In this field, you can record the name of the album.

Artist: In this field, you can record the name of the album’s artist. As you type, RioPort Audio 
Manager shows you the first item in the list of artists matching the letters you have typed. Click the 
drop-down arrow to select an artist you’ve already entered. 

Rating: To assign a numerical rating to the album, enter a number from 1-10 in this field. You may 
also click the up and down arrows to select a number. 

Genre: Assign a musical genre to the album in this field. You may either type in your own genre, or 
select one from the drop-down list. As you type, RioPort Audio Manager shows you the first item in 
the list of genres matching the letters you have typed. 

Source: In this field, record the source from which you acquired this album, or select one from the 
drop-down list. For example, if you recorded this album from a CD, select compact disc. As you type, 
RioPort Audio Manager shows you the first item in the list of sources matching the letters you have 
typed

Year: Use this field to record the year the album was released.

Custom 1-6: Use these fields to record information for which there is not already a data field. You can
edit a custom field name by selecting View from the menu bar, clicking Options, and then clicking the 
Custom tab. See the section regarding the Custom tab in Set preferences for more information about 
changing the custom field names.

Categories list: Use this list to assign categories to the album you’re editing. Categories help you 
organize your music files. To assign a category to an album, click in the Tag column next to the 
appropriate category. To add, rename, or delete a category, click the Add Category button. See 
Organize your database with categories for complete instructions.

Notes: Use the Notes field to enter any information you want to save in the album record for which 
there is not a separate field. 

3. Click the Track List tab to review or revise the individual song names in this album’s track list.
Review/Edit: Use the Review/Edit button to edit the song information for the song which is currently 
highlighted in the Album Song List. For more information on editing song information, see Edit song 
information.

Miniplayer bar: The Miniplayer bar is only active when you highlight a song which you have already 
recorded. Unrecorded songs can be edited from this window, but they cannot be played. Click the 
Play button to play the song. Click the Pause button to temporarily pause playing the song. To play 
the song again, click the Play or Pause button. Click the Stop button to stop playing the song. 

Drag the Volume control slider to the right to increase the volume. Drag it to the left to decrease the 
volume.

To move forward or backward in the song, drag the Song Position slider to the right or the left.

Submit to CDDB: Prior to recording the CD in the Copy from CD window, you probably accessed the 
CDDB Web site to obtain the CD’s title, artist, and track names. If the track information for this CD 
was not in the CDDB database or was incorrect in the CDDB database, you can update CDDB’s 
information for this CD. 



To do this, edit the album’s information and then click the Submit to CDDB button. CDDB requires 
that you include your email address with your CD information submission, so you must enter a valid 
email address on the CDDB Options tab. To do so, click View on the menu bar, and then click 
Options. 

You can only edit the album description information and the title and artist information for each 
individual song on the album. You cannot remove, rearrange, or add songs to the Album Song List.

For more information about the CDDB, see What is the CDDB?.

4. To save your changes and return to the Copy from CD window, click Save/Close.
To discard your changes and return to the Copy from CD window, click the Cancel button.



Stop recording
If necessary, you can interrupt the recording process. 

· Click the Stop Recording button. 

Any songs which have been fully recorded at that point will be added to your song database. Any 
songs which have not been recorded, or have only been partially recorded, will not be added.



What is the CDDB?
The CDDB (CD Database) is an information database containing artist, disc title, track titles, and other 
information for digital audio compact discs. Over time, this archive has grown to contain a substantial 
collection of CD information and is continuing to grow at a rapid rate. This database can be accessed by 
client applications via CDDB server hosts that have been set up on the Internet.

The CDDB data format and the CDDB servers are used by many client applications requiring CD 
information. CDDB has become the de facto standard for Internet access of compact disc information.

You can find out much more information about the CDDB database by going to its Web site at 
www.cddb.com.

Music CD-related data is provided through the Internet from the Escient® CDDB™ Music CD Database. 
Copyright © 1999 Escient, Inc. All rights reserved.

Escient is a registered tradmark of Escient, Inc. CDDB™ and the Escient CDDB logo are trademarks of 
Escient, Inc.



Transfer music to a portable player device
If you have a portable digital audio player device, you can use RioPort Audio Manager to transfer and 
manage songs on the device. Use the Devices tab to perform these tasks. Once the songs are stored on 
your portable device, you can carry them with you and listen to them anywhere.

While you are working with the portable device in the Devices window, you cannot play songs or 
otherwise use the controls on the device. Additionally, any other devices (printers, external drives, etc.) 
which are attached to the same port will probably not be accessible. When you switch to another window 
or close the RioPort Audio manager, you can interact with devices on that port.

Before transferring or managing songs on your portable device, make sure that it is connected to a port 
on your computer, and that this port is specified in the Portable tab of the Options dialog box. For more 
information, see the Portable tab section in Set preferences and the documentation for your portable 
device. 

If your device is not properly connected to your computer when you open the Devices window, RioPort 
Audio Manager displays a message. Verify the device is properly connected to the computer. As long as 
the device is not attached to the computer, the Devices window is inactive.

You can set options for transferring songs to the portable device, such as the Transcode Bit Rate. RioPort
Audio Manager can re-encode songs as they are transferred to your portable player device. This is 
especially useful when you would like to fit more songs on your portable device and you are not as 
concerned about the sound quality. Keep in mind that song files can only be re-encoded at a lower bit 
rate. For more information about these options, see the section concerning the Portable tab in Set 
preferences.

What do you want to do?

Transfer songs to a portable device 
Add songs to your Transfer List
Create an album from your Transfer List
Select songs to transfer to your portable device 
Transfer selected songs to the portable device 
Work with the songs on the portable device 



Transfer songs to a portable device

To transfer songs to your portable device:

1. On the Devices window, add songs to your Transfer List.
For more information, see Add songs to your Transfer List.

To create a Transfer List that you can easily access later, save the list as an album. For more 
information, see Create an album from your Transfer List.

2. Tag the songs that you want to transfer to your portable device.
See Select songs to transfer to your portable device for more information.

Refer to the Usage bar above the portable song list to make sure that you do not tag more songs than
will fit on the portable device.

3. Click the Copy to Portable button.
This will start the transfer process. As the songs are transferred, a Status box shows you the progress
of each song. See Start recording for more information.

If you want to stop the transfer, click the Abort button.

During the transfer, you cannot use other parts of RioPort Audio Manager, though you can work in 
other programs without interrupting the transfer process.

4. Organize the songs, if necessary.
See Work with the songs on the portable player for more information.



Add songs to your Transfer List
To transfer songs to your portable player, you must first add the songs that you want to transfer to the 
Transfer List on the Devices window.

1. To add the songs in your current song list on the Playlist window, right-click in the song list 
and select Send Songs to Portable Device.
If you have a set of songs in your current song list on the Playlist window, you can send those songs 
to the Transfer List on the Devices window.

Right-click in the song list and select Send Songs to Portable Device. The Devices window opens and
the songs from that song list will be in the Transfer List.

2. To add individual songs to the Transfer List from the Devices window, click the Select Songs 
button. 
The Select Songs dialog box shows you a list of all of the songs in your song database. For each 
song, the list shows the song title, artist, playing time, rating, and genre. 

You can sort the list of songs by clicking a column heading. For example, click the Artist column 
heading to sort the list alphabetically by artist.

You can also use the Find feature to help you locate a song in the list. To use Find, click the header of
the column that you want to search. The column sorts alphabetically and the Find field moves to the 
bottom of that column. Begin to type the name you want to find, and the highlight bar moves to the 
first item beginning with those letters or numbers. As you continue typing, the Find feature highlights 
the match closest to the text you type.

You can also edit song information by clicking the song and then clicking the Edit button. For more 
information on editing songs, see Edit song information.

3. Select the song(s) that you want to add to your Transfer List.
Tag a song that you want to add to your Transfer List by clicking in the Tag column next to that song. 
To tag all of the songs in the list, click the Tag All button. To untag all songs that are currently tagged, 
click the Untag All button.

4. Click the Add Items button.
To add the tagged songs to your Transfer List, click the Add Items button. To disregard the tagged 
songs and close this window without adding anything to your Transfer List, click the Done button.

5. To add all of the songs from selected album records to the Transfer List on the Devices 
window, click the Select Albums button.
The Select Albums dialog box shows you a list of all of the album records that are stored in your 
album database. For each album, the list shows the album name, artist, rating, and genre. 

You can sort the list of albums by clicking a column heading. For example, click the Artist column 
heading to sort the list alphabetically by artist.

You can also use the Find feature described in Step 2 above to help you locate a song in the list. 

You can also edit song information by clicking the song and then clicking the Edit button. For more 
information on editing songs, see Edit song information.

6. Select the albums from which you would like to add songs to your Transfer List.
To add all of the songs from an album to your Transfer List, you will need to tag it. You can tag an 
album by clicking in the Tag column next to that album. To tag all of the albums in the list, click the Tag
All button. To untag all albums that are currently tagged, click the Untag All button.

7. Click the Add Items button.
To add all of the songs from the tagged albums to your Transfer List, click the Add Items button. To 



disregard the tagged albums and close this dialog box without adding anything to your Transfer List, 
click the Done button.



Select songs to transfer to your portable device
To transfer songs to your portable player, tag them first. Since the amount of memory available on the 
device is limited, be careful to not select more songs than you can store on the portable device.

1. By default, when songs are added to the Transfer List, they are automatically tagged.
You can untag or retag songs by clicking in the Tag column on the left side of the Transfer List. A 
check mark in the Tag column indicates that the song is tagged to be transferred to the portable 
device.

2. Arrange the songs in the order you want them to appear on the portable device.
Songs are transferred to the portable player device in the order in which they appear in the Transfer 
List. Click the Remove button to remove the selected song from the Transfer List. Click the Up button 
to move the highlighted song up one position in the Transfer List. Click the Down button to move the 
highlighted song down one position in the Transfer List.

3. Refer to the Device Usage bar on the right side of the Devices window.
Refer to the Usage bar to see if you have enough space on your portable device for the songs you 
have selected in the Transfer List. 

The Usage bar shows the current memory usage status of the internal or external memory in the 
portable device (depending on whether you have “Internal” or “External” checked). The amount of 
memory already used on the portable device is shown in green. The amount of memory required to 
store the tagged tracks is shown in yellow. The amount shown in red represents the portion, if any, of 
the amount that you have tagged that exceeds the amount of memory available on your portable 
device. If any amount is showing in red, you must untag some songs in the Transfer List or remove 
some songs from the portable device before you can transfer your songs to the portable device. 

To allow more songs to fit on the device, you can also set RioPort Audio Manager to transcode songs 
as they are transferred to the portable device. Transcoded files take up less space on the portable 
device. For more information about setting up this option, see the section concerning the Portable tab 
in Set preferences.



Create an album from your Transfer List
RioPort Audio Manager lets you create your own custom album. This is especially helpful when you have 
created a song list in the Transfer List that you want to access easily in the future. Add the songs you 
want to the Transfer List, organize the songs in the order you want, and save the list as an album.

1. On the Devices window, click the Clear List button, if necessary.
If you want to create an album from scratch, click the Clear List button to start with a blank Track List.

2. Add the songs you want on your custom album to the song list.
For complete instructions, see Add songs to your Transfer List. 

3. Organize the songs in the order you want.
RioPort Audio Manager transfers songs to the portable device in the order they appear in the Transfer
List. By organizing the songs now and saving them as an album, you can later add that album to your 
Transfer List to send those songs to your portable device. 

To move a song up in the list, highlight the song and then click the Up Arrow button. To move a song 
down in the list, highlight the song, and then click the Down Arrow button.

To remove a song from the current song list, click the Remove button (the trashcan icon). This only 
deletes the song from the Transfer List, not from your song database. You can add it to the list again if
you like. 

4. Click the Save List as Album button.
The Add Album dialog box opens.

5. Enter an album description and any other information, and then click Save/Close.
For complete instructions, see Edit album information. If you decide that you do not want to create 
this album, you can click the Cancel button to close this dialog box and return to the Devices window 
without creating this album.



Transfer the selected songs to the portable device
After you have selected and organized the songs that you would like to send to the portable device in 
your Transfer List, you are ready to transfer the songs to the device. 

1. Make sure your portable player is connected to the correct port on your computer.
RioPort Audio Manager expects to find the portable player on the port specified in the Portable tab of 
the Options dialog box. See the information regarding the Portable tab in Set preferences for details. 
See your portable player documentation for more information on connecting the portable player to 
your computer.

2. Select how you want to transfer songs.
If you have a supplemental memory card in your portable device, you must select whether you want 
to transfer songs to the portable device’s internal memory or to the supplemental memory card.

You transfer songs from the Transfer List to the memory unit you checked in the Memory bar. The 
Memory bar is located on the right side of the Devices window, directly above the Device Usage bar. 
Check the Internal button to display the songs and data files stored on the portable player device’s 
internal (built-in) memory. If you have a supplemental memory card inserted in your portable device, 
check the External button to display the songs and data files which are stored on it. 

3. Click the Copy to Portable button.
RioPort Audio Manager copies the tagged songs to the portable device. As each song is transferred, 
you see a progress bar showing the status of the transfer

If you have specified in the Options dialog box that you want RioPort Audio Manager to transcode 
songs as they are transferred to the portable device, you see a progress bar showing status of the file
conversion. When the file has been converted, the Sending to Rio dialog box opens to show the 
progress of the song transfer. For more information about the Transcode Bit Rate option, see the 
section concerning the Portable tab in Set preferences.

When all of the songs have been transferred, a dialog box opens and lists how many songs were 
transferred successfully.

4. If necessary, stop the transfer process at any point.
If you decide at any point that you would like to stop the song transfer process, click the Abort button 
on the Sending to Rio or the Converting File dialog box. Any songs that have already been fully 
transferred will be available on the portable device. Any that were not transferred or were only 
partially transferred will not be available on the device. 



Work with the songs on the portable device
Once you have transferred songs to the portable player, you see the songs listed in the Portable Song 
List, as long as the portable device is attached to the computer. The Portable Song List displays the song 
file name, file size (in kilobytes), and playing time (in minutes and seconds) for each song currently stored
on the portable player device. You can rearrange the order of these songs or remove songs. You can also
format the internal and external memory in the portable device. Any changes that you make to the 
portable device are reflected in both the Portable Song List and on the device itself.

1. Organize the songs on the portable device.
The order of the songs in the Portable Song List reflects the order of the songs on the portable 
device. Use the Internal and External buttons to switch the view between the device’s built-in memory
and a supplemental memory card. Click the Remove button (the trashcan icon) to remove the 
selected song from the portable device. Click the Up button to move the highlighted song up one 
position on the portable device. Click the Down button to move the highlighted song down one 
position on the portable device

2. To erase all of the data on the portable device, use the Format Media button.
Click the Format Media button to erase the internal or external memory on the portable device. 
Choose the Internal or External button to make sure that you are viewing the memory that you want to
format.

3. If you switch supplemental memory cards, refresh the view to read the songs on the 
supplemental memory.
Click the Refresh button to read the current song information from the portable device again. 

Note concerning the Copy from Portable button: Some newer portable devices allow you to store data
files. You can copy these data files from those devices to your hard drive. If you have data on your 
portable device, click the Copy from Portable button to begin copying that data from your device to your 
hard drive.



Visit the Internet to get music
You can download digital audio files from the Internet. You can have RioPort Audio Manager detect these 
files as they are added to your hard drive and add them to your song database. 

1. To download audio files from a Web site, click the RioPort button. 
Your existing Internet connection is used to connect to the RioPort.com Web site, where you can take 
advantage of a variety of products, services, and information related to music on the Web, including 
the ability to search for, buy, and download music.

2. Download files from here or navigate from RioPort.com to other sites that offer digital audio 
downloads. 
The RioPort.com Web site provides you with a portal to the world of digital audio. This Web site offers
downloads (some of which are free, some of which may be purchased) from a variety of partners. You
can follow links from this Web site to many other locations on the Web where you may download 
digital audio files. If you know the Web address of a specific site that you would like to visit, you can 
type this in the Address field on this window and click the Enter key on your keyboard. The controls 
on this window (Back, Forward, Stop, and Home) work just like your Web browser.

3. To search for audio files on the Web, use one of the search engine links on the RioPort.com 
Web site. 
The RioPort.com portal offers several search engines that you can use to search for digital audio files 
on the Web. Most of these search engines allow you to search by artist, song title, and audio file type.

4. After you find an audio file that you want, download it to your hard drive. 
Typically, to download a file from the Internet, you click the link for the file that you want to download. 
Specify where you want to store the file on your hard drive, and your browser downloads the file. See 
the documentation for your Web browser for more information on downloading files from the Internet.

5. Add the downloaded song file to your song database, if you like.
To have RioPort Audio Manager automatically add the downloaded music file to the database, check 
the “Add song to database when song file is downloaded” box on the General tab in the Options 
dialog box. For more information on setting up your options, see the section regarding the General 
tab in Set preferences.



Set preferences
Use the Options dialog box to personalize your RioPort Audio Manager settings. To open the Options 
dialog box, select Options from the View menu or click F10 on your keyboard. To edit the options, click 
the appropriate tab. When you have made all of your changes, click the OK button to save your changes 
and close this dialog box. To discard the changes you have made and leave the options as they were set 
previously, click the Cancel button.

General tab

Use the General tab to set general application options for RioPort Audio Manager.

Show tool tips: If you want to see a brief description of an object, such as a button or field, when you
point to an object, check this box. If you don’t want to see this description, clear this box.

Add song to database when song file is downloaded. When RioPort Audio Manager is running, it 
can monitor your hard drive and prompt you to add newly downloaded or copied songs to your song 
database. To use this feature, check this box. If you do not want the software to monitor your hard 
drive, clear this box.

Skins: From the drop-down list, select the color scheme you want to use in RioPort Audio Manager. 

Tab Size: From the drop-down list, select the tab size you want to use for displaying the Playlist, 
Copy from CD, Devices, and RioPort buttons at the top of your window.

Temp Directory: RioPort Audio Manager uses a directory to temporarily store files when it is 
performing various operations. By default, it uses the same Temp file Windows uses (c:\Windows\
Temp). To change this directory, type the full path of the directory where you want to store temporary 
files. You can also click the ellipsis button (…) to the right of this field to browse for a directory.

Reset all “Don’t Show This Again” flags: If you have checked the Don’t Show This Again box on 
any special dialog boxes (such as the Empty Play List dialog box) and want that dialog box to appear 
again, click this button. This resets all of the special dialog boxes.

Storage tab
Use the Storage tab to set the options for storing songs you record from CDs and for adding songs to 
your database.

Song Directory: During the installation of RioPort Audio Manager, you specified the directory where 
you wanted recorded song files stored. To change this directory, type the full path of the directory 
where you want to store recorded song files. You can also click the ellipsis button (…) to the right of 
this field to browse for a directory.

Output File Format: From the drop-down list, choose the format you want RioPort Audio Manager to 
use when recording songs from your CDs to your hard drive. The file name for the recorded song will 
be in this format.

Replace space with underscore: When RioPort Audio Manager records songs from CDs, it can 
replace any spaces in the song file name with underscores. For example, it can change “my favorite 
song.mp3” to “my_favorite_song.mp3”. If you want to replace spaces with underscores, check this 
box. If not, clear the box.

Create directory for album: When you record from a CD, RioPort Audio Manager can create a 
subdirectory (in the Song Directory specified above) in which to store all songs recorded from that 
CD. If you want to create this subdirectory for each CD, check this box. If you would rather store all of 
the songs that you record from CD in your Song Directory without a separate subdirectory for each 
CD, clear this box.

Create album from song directory name: When songs are added to the database, RioPort Audio 
Manager can create an album record in your album database for each directory and subdirectory on 
your hard drive which contains music files. For example, if you added all of the music files from the 



directory c:\party songs, an album record would be created called “party songs” and it would contain 
all of the songs that you added from that directory. If you would like for the software to do this, check 
this box. If not, clear the box.

Read CD tab

Use the Read CD tab to specify settings to use when reading and recording from an audio CD

Drive: From the drop-down list, select the letter of the CD drive which you want to read or record. 
RioPort Audio Manager automatically detects all of the CD drives installed on your computer.

CD Read Method: From the drop-down list, select the method you want to use to read CDs. Digital 
(VxD) reads songs straight from your CD digitally. Digital (WinAspi) uses software to digitally read 
songs from your CD. Analog plays the song from the CD and records it using your sound card. The 
method that works best depends on your CD drive. If you are not sure which method to use, click the 
Configure it for me button and RioPort Audio Manager will select the best method for your CD drive.

Configure it for me: Click this button if you want RioPort Audio Manager to analyze your CD drive 
and select the CD Read Method for you. 

Record file as: From the drop-down list, select the file format you want to use when recording audio 
files from CD, such as Mpeg (MP3) or Microsoft Windows Media Audio (WMA).

Bit Rate: From the drop-down list, select the bit rate at which you would like audio files to be 
recorded. The higher bit rates take up more hard drive space and provide better sound quality, while 
the lower bit rates require less hard drive space, but provide lower sound quality.

CDDB tab

Use the CDDB tab to set options for using the CDDB Web site to obtain CD information 

CD Database Site: From the drop-down list, select the CDDB Web site you would like to use to 
access CDDB information.

Update CDDB Site List: Click this button if you want to update the list of Web sites from which CDDB
information may be downloaded.

Always get title from CDDB when CD is inserted: If you always want RioPort Audio Manager to 
connect to the Internet and download CD information from the CDDB Web site when you insert a new
CD in your drive, check this box. If you would rather be asked whether or not to connect to the 
Internet and download this information each time you insert a new CD, uncheck this box.

Email address: If you plan to submit information to the CDDB Web site, CDDB requires that you 
include your email address with your CD information submission. They will use this email address to 
contact you if there is a problem or question with the information you submit.

Goto CDDB Website: Click this button to open your Internet browser and navigate to the CDDB Web 
site.

For more information about the CDDB, see What is the CDDB?.

Player tab

Use the Player tab to specify options for the playback of songs.

Music Player: From the drop-down list, select a music player you would like to use for song playback.
You may use the RioPort Audio Manager Player or an external player like WinAmp.

Update Rate: From the drop-down list, select the rate at which you want the RioPort Audio Manager 
Player’s Spectrum Analyzer to update. The Spectrum Analyzer is the display beneath the counter on 
the Playlist window which provides a graphic representation of the song currently playing. If you are 
experiencing problems during playback (such as slow response from other applications or a “clipping”
of the song as it is playing) due to strains on your computer’s processor, you may want to lower this 
rate, or turn it off completely by selecting None.



Portable tab

Use the Portable tab to set options for communicating with a portable player device.

Comm Port: From the drop-down list, select the communications port on your computer to which your
portable player device is connected.

Transcode Bit Rate: RioPort Audio Manager can re-encode songs as they are transferred to your 
portable player device. This is especially useful when you would like to fit more songs on your 
portable device, and you are not as concerned about the sound quality. From the drop-down list, 
select the bit rate at which you would like song files to be re-encoded as they are transferred to your 
portable device. Keep in mind that song files can only be re-encoded at a lower bit rate. If you want to
leave song files as they are when you transfer them to the portable device, select “None” from the 
drop-down list. 

Portable: From the drop-down list, select the portable player device to which you would like to 
transfer music files from RioPort Audio Manager. This list displays all of the portable devices which 
RioPort Audio Manager detects have been installed on this computer.

Custom tab

Use the Custom tab to personalize the names of your six custom fields.

Custom 1-6: In this field, enter the name of the field as you want it to appear in the Edit Song and 
Edit Album dialog boxs.



Menu Bar Quick reference
File menu Search Hard Disks for Songs , Add Songs, Review New Songs, Exit 

View menu Playlist, Copy from CD, Portable, Internet, Small Player, Options

Skins menu Default Skin

Help menu Help Topics, Help On, Register, Unlock Program, Other colors, About RioPort 
AudioManager 



Search Hard Disks for Songs
If you want RioPort Audio Manager to search your hard drive for music files, choose this option from the 
File menu. These songs will be added to your song database.



Add Songs
Choose this option from the File menu to manually search for and add songs to your song database from 
your hard drive.



Review New Songs
Choose this option from the File menu to review any songs which have been added to your database but 
not yet reviewed. This might include songs that were added from your hard drive or songs that have been 
downloaded from the Internet. 



Exit
Choose this option from the File menu to close RioPort Audio Manager.



Options
Choose this command from the View menu to open the Options dialog box, where you can personalize 
your preferences for working with RioPort Audio Manager.



Default Skin
Choose this option from the Skins menu to change the color scheme in RioPort Audio Manager to the 
default “skin”. If you have downloaded and installed other color schemes, they are also be listed under 
the Skins menu.



Visit Partners
Choose this option from the Help Menu to connect to the Internet and visit the Web sites of some of 
RioPort’s partners in the design and operation of RioPort Audio Manager.



Playlist
Choose this option from the View menu to access the Playlist window, where you can listen to songs from
your song and album databases, and organize songs into song lists.



Copy from CD
Choose this option from the View menu to record music from a CD into your song database.



Portable
Choose this option from the View menu to transfer music files from your computer to your portable player 
device.



Internet
Choose this option from the View menu to connect to the RioPort.com Web site, where you can learn 
more about RioPort products and services. The RioPort.com Web site also includes links to other sites 
where you can find, buy, and download music and related items.



Small Player
Choose this option from the View menu to transform RioPort Audio Manager into a Small Player which 
allows you to play the songs in your current song list.



Help Topics
Choose this option from the Help menu to open this Online Help file.



Help On
Choose this option from the Help menu to see context-sensitive help on an item in RioPort Audio 
Manager. When you select this item, your cursor changes to a question mark pointer. Click this pointer on 
an item to see a description of that item.



Register
Choose this option from the Help menu to register your copy of the RioPort Audio Manager software.



Unlock Program
Choose this option from the Help menu to enter the certificate number you received after registration. 
After you have unlocked the program, you will have unlimited encoding capabilities.



About RioPort Audio Manager
Choose this option from the Help menu to see the version number and copyright information for RioPort 
Audio Manager.



For more information on RioPort Audio Manager
If you have a question that the RioPort Audio Manager Online Help file cannot answer, you can contact 
RioPort Technical Support. To check copyright information, click the link listed below. To find out how to 
print help sections to create a hard copy of this Online Help file, clink on the link below.

What do you want to do?

Contact technical support 
Read copyright information 
Print help sections 



Contact technical support
Visit the RioPort Web site at www.rioport.com to see answers to Frequently Asked Questions and to find 
information about product updates.

You can also E-Mail the RioPort technical support staff directly at:

Support@rioport.com



Read copyright information

Copyright and trademarks

Copyright Ó 1999 RioPort, Inc. All rights reserved.

RioPort and the RioPort logo are trademarks of RioPort, Inc. Microsoft, Windows, the Windows 
logo, and Windows NT are registered trademarks of Microsoft Corporation. All other brands and 
product names may be trademarks or registered trademarks of their respective holders.

Music CD-related data is provided through the Internet from the Escient® CDDB™ Music CD 
Database. Copyright © 1999 Escient, Inc. All rights reserved.

Escient is a registered tradmark of Escient, Inc. CDDB™ and the Escient CDDB logo are 
trademarks of Escient, Inc.

MP3 technology provided by Qdesign Corporation. For more information visit www.qdesign.com.

Xaudio MPEG Audio Engine © 1996-1998 by Mpeg TV, LLC. All rights reserved. 

Winamp is a product of Nullsoft.

Portions based upon Microsoft Windows Media Technologies. Copyright © 1999 Microsoft 
Corporation. All rights reserved.

Disclaimer and limitation of liability

RioPort, Inc. assumes no responsibility for any damage or loss resulting from the use of this 
documentation. Neither does it assume responsibility for any loss or claims by third parties which 
may arise through the use of this software. Be sure to regularly make backup copies of all 
important data on other media to protect against data loss.

Please read the RioPort End User Software License Agreement included in your package before 
using the accompanying software program. Using any part of the software indicates that you 
accept the terms of the RioPort End User Software License Agreement.



How to print help sections
1. Click the Help Topics button on this window.
2. Click on the Contents tab and open the book labeled Print Help Sections.

You will see a list of help sections you can print.

3. Highlight the section you want to print.
You can open sections and print only the topics that you want. 

4. Click the Print button.
You can also choose Print from the File menu.



Playlist tab
Click this button to work with the Playlist, where you can listen to songs from your song and album 
databases, and organize songs into song lists.



Copy from CD tab
Click this button to record music from a CD into your song database.



Devices tab
Click this button to transfer music files from your computer to your portable player device. 



RioPort tab
Click this tab to connect to the RioPort.com web site, where you can learn more about RioPort products 
and services. The RioPort.com web site also includes links to other sites where you can find, buy, and 
download music and related items.



Playlist window
This window shows the songs you’ve added to your current song list. You can add, remove, and arrange 
songs however you like to create custom song lists. You can even save your custom song lists as albums 
so that you can easily access them later. This window also has the audio player controls which you can 
use to play the songs in the current song list



Add Songs to the Song List button bar 
Use this button bar to add songs to your current song list. Click the Select Songs button to select 
individual songs from your song database and add them to your current song list. Click the Select Albums 
button to add all of the songs from selected albums in your album database to your current song list.



Song List
The Song List shows information about the songs in your current song list. The Song List shows the song 
title, artist, original album, and playing time for each song.



Organize the Song List button bar 
Use this button bar to work with the songs in your Song List. Click the Clear List button to clear all the 
songs from the current song list. Click the Save List as Album button to save your current song list as an 
album that you can easily access later.

Click the Remove button to remove the selected song from the list. Click the Up button to move the 
selected song up one position in the Song List. Click the Down button to move the selected song down 
one position in the Song List. 



Copy from CD window
Use the Copy from CD window to record songs from a CD to your hard drive. The songs will be recorded 
as compressed, digital music files. The Copy from CD window includes the Track list, which shows 
information about the tracks on the CD in your CD drive, the Status box, which reflects the recording 
status of tracks you’re recording, and related button bars.



Copy from CD button bar
To record music from an audio CD, insert the CD in the CD drive. RioPort Audio Manager reads the CD 
and shows you the tracks in the Track List.

Click the Get Song Titles button to get song titles from the CDDB web site. Click the Edit Titles button to 
add or change the CD or track information. This feature is especially useful if your CD is not listed on the 
CDDB web site. Click the Start Recording button to record the tracks you’ve tagged in the Copy from CD 
Track list. Click the Stop Recording button to stop converting tracks from the CD format to MP3 files.

Note: The CDDB is a database containing artist, disc title, track titles, and other information for digital 
audio compact discs. CDDB has become the de facto standard for Internet access of compact disc 
information. You can use RioPort Audio Manager to access this database via CDDB server hosts on the 
Internet. 



Copy from CD Track list
This list shows the title of the audio CD in your CD drive, and the title, artist, and length of each track on 
the CD. Tag the tracks you want to record onto your hard drive by clicking in the Tag column. . This list 
also calculates and displays the number of tracks you’ve tagged, and the space required to record the 
tagged tracks onto your hard drive



Copy from CD Track list button bar
Use this button bar to work with the items in the Track list. Click the Refresh button to read the information
from the CD in your CD drive again. Click the Tag All button to tag all the tracks in the list. Click the Untag 
All button to clear the checks in the Tag column for all the tracks in the list. 



Status box
The Status box displays the current progress of the recording progress. The Status bar shows the 
recording progress of the track which is currently being read and compressed. The Overall Status bar 
displays the overall recording progress of all of the tracks which you selected to record.



Devices window
Use the portable player device window to transfer songs to the portable player. In the Transfer List, tag 
the songs you want to transfer to the portable device. Songs which are currently stored on the portable 
device are displayed and can be rearranged or removed in the Portable Song List. To transfer data files 
stored on the portable device to your hard drive, click the Copy from Portable button.



Devices window button bar
Use the Devices window button bar to add songs to the Transfer List and transfer them to your portable 
player device. Click the Select Songs button to add the songs from your song database to the Transfer 
List. You can then tag the songs you want to transfer. Click the Copy to Portable button to transfer the 
tagged songs from the Transfer List to your portable device. Click the Copy from Portable button to 
transfer data files from the portable device to your hard drive.



Portable Song List button bar
Use this button bar to rearrange or remove with the songs stored on your portable player device. Click the
Refresh button to redisplay the current song information on the portable player. Click the Format Media 
button to erase the internal or external memory on the portable device. 

The order of the songs in the Portable Song List reflects the order of the songs on the portable device. 
Click the Remove button to remove the selected song from the list. Click the Up button to move the 
selected song up one position in the list. Click the Down button to move the selected song down one 
position in the list.



Transfer List
The Transfer List shows information about the songs that you have selected to transfer to your portable 
player device, including the playing time, song file size, song title, and artist. Tag the songs that you want 
to transfer to your portable device by clicking in the Tag column. This list also calculates and displays the 
number of songs you’ve tagged, and the space required to store the selected tracks on your portable 
device. 



Organize the Transfer List button bar
Use this button bar to work with the songs in the Transfer List. Click the Clear List button to clear all the 
songs from the Transfer List. Click the Save List as Album button to save the songs your current Transfer 
List as album you can easily access later. 

Songs are transfer to the portable player device in the order they appear in the Transfer List. Click the 
Remove button to remove the selected song from the list. Click the Up button to move the selected song 
up one position in the Song List. Click the Down button to move the selected song down one position in 
the Song List. 



Device Usage bar
Refer to the Usage bar to see if you have enough space on your portable device for the songs you have 
selected in the Transfer List. This Usage bar displays a gauge which shows the current memory usage 
status of the internal or external memory in the portable device (depending on whether you have 
“Internal” or “External” checked). The amount of memory which has already been used on the portable 
device is shown in green. The amount of memory that is required to store the tracks that you have tagged
in the Transfer List is shown in yellow. The amount shown in red represents the portion, if any, of the 
amount that you have tagged that exceeds the amount of memory available on your portable device. If 
any amount is showing in red, you must untag some songs in the Transfer List or remove some songs 
from the portable device before you will be able to transfer your songs to the portable device."



Portable Song List
The Portable Song List shows the song file name, length (in minutes and seconds), size (in kilobytes), 
and the title of the songs stored on the portable player device.



Memory bar
Click the Internal button if you want to show the songs and data files stored on the portable player’s 
internal (built-in) memory. If you have a supplemental memory card in your portable device, click the 
External button to show the songs and data files which are stored on it. Songs you transfer from the 
Transfer List are always transferred to the memory unit checked in the Memory bar.



RioPort window
This window uses your connection to the Internet to take you to the RioPort.com web site, where you can 
take advantage of a variety of products, services, and information related to music on the Web, including 
the ability to search for, buy, and download 

To navigate to a different web site, follow links from the RioPort.com web site. To manually navigate to a 
specific Web address, type the address in the Address field or select a Web address from the Address 
drop-down list. To move back to the previous Web address, click the Back button. To forward move to the 
next Web address, click the Forward button. Click the Stop button to stop downloading the current page. 
Click the Home button to return to the RioPort.com Home page. Click the Disconnect button to disconnect
from your dial-up connection.



Song details
This box shows details about the selected song, including its title, artist, genre, rating, year released, 
category, and other information. If you are currently on the Playlist window, you may edit these details by 
right-clicking on the song and selecting Edit Song. If you are currently on the Copy from CD window, you 
can edit these details by clicking the Edit Titles button and then highlighting the appropriate song and 
clicking Review/Edit.



Album details
This box shows details about the selected album, including title, artist, song list, and physical location.



Categories list
This list allows you to assign categories to the song or album you’re editing. Categories help you organize
your music files. To assign a category to a song or album, click in the Tag column next to the appropriate 
category. To add, rename, or delete a category, click the Add Category button.



Notes
Use the Notes field to enter any information you want to save in the song or album record for which there 
is not a separate field. 

RioPort Audio Manager includes a feature which allows you to connect to the Internet and navigate to a 
web site by clicking on the song artist’s name in the Detail box on the Playlist screen. To be able to link to 
a web site, you must enter the URL (address) for that web site as the first line of the Notes field in one of 
the following formats:    “http://(address)” or “!/(address)”. For example, you could enter 
“http://www.myfavoriteband.com” or “!/www.myfavoriteband.com”, but not “www.myfavoriteband.com”.



Player button bar
Use the Player button bar to control the playback of the songs in your current Song List. 

Click the Back button to skip to the previous song. Click the Play button to play the current song. Click the
Pause button to temporarily pause playing the song. Click the Stop button to stop playing. Click the Fwd 
button to skip to the next song.

To move forward or backward in the song, drag the Song Position slider to the right or the left.

Drag the Volume slider to the right to increase the volume. Drag it to the left to decrease the volume. 

Drag the Stereo Balance slider to adjust the balance between the left and right speakers.

By default, RioPort Audio Manager plays once through all of the songs in the Song List in the order in 
which they are listed.

Click the Shuffle button to enable the Random Play Mode. In Random Play Mode, RioPort Audio Manager
will play once through all of the songs in the Song List in a random order.

Click the Rep button if you want to enable the Continuous Play Mode. In Continuous Play Mode, RioPort 
Audio Manager will play through the songs in your Song List in order until you stop it. After it plays the last
song in your Song List, it will start over from the beginning.

Click both the Shuffle button and the Rep button to continuously play through all of the songs in your 
Song List in a random order. With both modes enabled, RioPort Audio Manager will continue to play until 
you stop it.



Miniplayer bar
Use the Miniplayer bar to preview the selected song. Click the Play button to play the song. Click the 
Pause button to temporarily pause playing. To play the song again, click the Play or Pause button. Click 
the Stop button to stop playing the song.

Drag the Volume slider to the right to increase the volume. Drag it to the left to decrease the volume. Drag
the Song Position slider to move forwards or backwards in the song.



Edit Album dialog box 
Use the Edit Album dialog box to enter or edit a description of an album and to edit the album’s track list.

If the track information for the CD is not in the CDDB database or is incorrect, you can update CDDB’s 
information for this CD. To do so, edit the album’s information and then click the Submit to CDDB button. 
CDDB requires that you include your email address with your CD information submission, so you must 
enter a valid email address on the CDDB tab in the Options dialog box. (Click View on the menu bar , 
click Options, and then click CDDB). 

Click the Save/Close button to save the album information and close the dialog box. Click the Cancel 
button to discard your entries or changes and close the dialog box.

Note: The CDDB is a database containing artist, disc title, track titles, and other information for digital 
audio compact discs. CDDB has become the de facto standard for Internet access of compact disc 
information. You can use RioPort Audio Manager to access this database via CDDB server hosts on the 
Internet. 



Edit Album description tab
Enter or edit the description of the current album.

Album: In this field, enter the name of the album.

Artist: In this field, enter the name of the album’s artist. As you type, RioPort Audio Manager shows you 
the first item in the list of artists matching the letters you typed. Click the drop-down arrow to select an 
artist you’ve already entered. 

Rating: To assign a numerical rating to the album, enter a number from 1-10 in this field. You can also 
click the up and down arrows to select a number. 

Genre: Assign a musical genre to the album in this field. You can either type your own genre, or select 
one from the drop-down list. As you type, RioPort Audio Manager shows you the first item in the list of 
genres matching the letters you typed. 

Source: In this field, record the source from which you acquired this album, or select one from the drop-
down list. For example, if you recorded this album from a CD, select compact disc. As you type, RioPort 
Audio Manager shows you the first item in the list of sources matching the letters you typed.

Year: Use this field to record the year the album was released.

Custom 1-6: Use these fields to record information for which there is not already a data field. You can edit
a custom field name by selecting View from the menu bar, clicking Options, and then clicking the Custom 
tab. 



Edit Album Track List
Use the Track List tab to edit the song order on the album’s track list. You can add songs, remove songs 
from the list, and change their order. This tab also displays detailed information about the highlighted 
song. On this tab, you can also preview a song using the Miniplayer buttons.”



Album Song List
The Album Song List shows the songs on the current album record, including the track number, song title,
artist, playing time (in minutes and seconds), and file size. It also shows the total number of songs and 
the total playing time of the album.



Edit Album Song List button bar
Use this button bar to work with the songs in the Album Song List. Click the Clear List button to clear all of
the songs from the current Album Song List. 

Click the Add Song button to access the Select Songs window and select additional songs to add to the 
Album Song List.

Click the Remove button to delete the selected song from the Song List. Click the Up button to move the 
selected song up one position in the list. Click the Down button to move the selected song down one 
position in the list.



Edit Song dialog box
Use the Edit Song dialog box to enter or edit information related to this song record. In the Song tab, you 
can enter or edit a description of a song, preview the song, assign a category to a song, and add notes. In
the Advanced tab, you can enter or edit advanced information, such as the sample rate and quality of the 
recording.

If you have accessed the Edit Song dialog box from the Select Songs dialog box, the number of this song 
record in your database will be displayed in the lower left corner of the window. Click the Prev button to go
to the song record previous to this one in your song database. Click the Next button to go to the next song
record in your song database. 

Click the Save/Close button to save your entries or changes and close the Song dialog box. Click the 
Cancel button to discard your changes and close the Song dialog box.



Song tab
Use the Song tab to record or edit information about the song you are currently editing.

Title: In this field, you can record the title of this song.

Artist: In this field, you can record the name of the song’s artist. As you type, RioPort Audio Manager 
shows you the first item in the list of artists matching the letters you have typed. Click the drop-down 
arrow to select an artist you’ve already entered. 

Written By: You can record the name of the songwriter in this field.

Original Album: In this field, you can enter the name of the album on which the song originally appeared,
or select one from the drop-down list.

Genre: Assign a musical genre to the song in this field. You may either type your own genre, or select one
from the drop-down list. As you type, RioPort Audio Manager shows you the first item in the list of genres 
matching the text. 

Rating: To assign a numerical rating to the song, enter a number from 1-10 in this field. You can also click
the up and down arrows to select a number. 

Original Track: In this field, enter the track number of this song on its original album. You can also click 
the up and down arrows to select a number. 

Year: In this field, record the year the song was released.

Version: If multiple versions of this song exist, you can enter the version number for this recording of the 
song in this field.

File Name: Normally, this field contains the path and file name of the song file to which this record is 
linked. However, if you have moved or deleted the song file, enter the new path and file name, or browse 
to the new file location for this song record by clicking on the ellipsis button (“…”) located to the right of 
this field.”



Edit Song Advanced tab
Use the Advanced tab on the Song dialog box to enter or edit advanced information about the current 
song.

Encoder: In this field, select the encoder you used to encode the song. If the encoder you used is not 
listed, enter it to add it to your list. If you recorded this song with RioPort Audio Manager, the Encoder is 
automatically entered as “RioPort.”

Bit Rate: This field shows the bit rate at which this song was recorded. The bit rate is the amount of 
digital information stored per second of audio. The higher the bit rate, the better the sound quality, but the 
larger the file size. You cannot manually change this entry.

Sample Rate: This field shows the rate at which this song was sampled. For CD-quality sound, the 
sample rate is 44100. Like the bit rate, the higher this value, the better the sound quality, but the larger 
the file size. You cannot manually change this entry.

Source: In this field, record the source from which you acquired the song, such as compact disc or 
downloaded, or select one from the drop-down list. 

Quality: To assign a quality rating to this song file, select Excellent, Good, Fair, or Poor from the drop-
down list. You can also type your own rating to add it to your list.

Custom 1-6: Use these fields to record information for which there is not already a data field. You can edit
a custom field name by selecting View from the menu bar, clicking Options, and then clicking the Custom 
tab. 



Select Songs dialog box
This dialog box shows all of the songs in your RioPort Audio Manager song database. For each song, the 
list shows the song title, artist, playing time, rating, and genre. 

Click a song to see a detailed description in the Detail box. Click a song and then click the Edit button to 
edit the song description.

Tag the songs you want to add to your Song List by clicking in the Tag column next to the song you want. 
To tag all the songs in the list, click the Tag All button. To untag all tagged songs, click the Untag All 
button.

To add the tagged songs to your current Song List, click the Add Items button. To disregard the tagged 
songs and close this window without adding anything to your Song List, click the Done button.



Select Albums dialog box
This displays all of the albums in your RioPort Audio Manager album database. For each album, the list 
shows the album name, artist, rating, and genre. 

Click an album to see a detailed description in the Detail box. Click an album and then click the Edit 
button to edit the album description.

Tag the albums you want to add to your Playlist by clicking in the Tag column next to the album you want. 
To tag all the albums in the list, click the Tag All button. To untag all tagged albums, click the Untag All 
button.

To add all of the songs from the tagged albums to your current Song List, click the Add Items button. To 
disregard the tagged albums and close this window without adding anything to your Song List, click the 
Done button.



Select songs from list
Select the songs from this list that you want to add to your current Song List. For each song, the list 
shows the song title, artist, playing time, rating, and genre.

You can click a column heading to sort the list by that item. For example, click the Artist column heading 
to sort the list alphabetically by artist.

You can also use the Find feature to help you locate a song in the list. To use Find, click the header of the 
column that you want to search. The column sorts alphabetically and the Find field moves to the bottom of
that column. Begin to type the name you want to find, and the highlight bar moves to the first item 
beginning with those letters or numbers. As you continue typing, the Find feature highlights the match 
closest to the text you type.

To tag a song and add it to your Song List, click in the Tag column next to the song you want. To tag all 
the songs, click the Tag All button. To untag all the tagged songs, click the Untag All button. To edit a song
description, click the song and then click the Edit button.

To add the tagged songs to your current Song List, click the Add Items button. To disregard the tagged 
songs and close this window without adding anything to your Song List, click the Done button.



Select albums from the list
Select the albums from this list that you want to add to your current Album List. For each album, the list 
shows the album title, artist, playing time, rating, and genre.

You can click a column heading to sort the list by that item. For example, click the Artist column heading 
to sort the list alphabetically by artist.

You can also use the Find feature to help you locate a album in the list. To use Find, click the header of 
the column that you want to search. The column sorts alphabetically and the Find field moves to the 
bottom of that column. Begin to type the name you want to find, and the highlight bar moves to the first 
item beginning with those letters or numbers. As you continue typing, the Find feature highlights the 
match closest to the text you type.

To tag a album and add it to your Album List, click in the Tag column next to the album you want. To tag 
all the albums, click the Tag All button. To untag all the tagged albums, click the Untag All button. To edit a
album description, click the album and then click the Edit button.

To add the tagged albums to your current Album List, click the Add Items button. To disregard the tagged 
albums and close this window without adding anything to your Album List, click the Done button.



Options dialog box
Use the Options dialog box to personalize your RioPort Audio Manager settings. Click the tab 
corresponding to the type of change you want to make. For example, you can set options regarding 
where to store music files, where and how to read audio CDs, where to find the CD database web site, 
which music player device you want to use to play music, and how to work with a portable player.



Options dialog General tab
Use the General tab on the Options dialog box to set system-wide options for RioPort Audio Manager. 

Show tool tips: If you want to see a brief description of an object, such as a button or field, when you 
point to an object, check this box. If you don’t want to see this description, clear this box.

Add song to database when song file is downloaded. When RioPort Audio Manager is running, it can 
monitor your hard drive and prompt you to add newly downloaded or copied songs to your song 
database. To use this feature, check this box. If you do not want the software to monitor your hard drive, 
clear this box.

Skins: From the drop-down list, select the color scheme you want to use in RioPort Audio Manager. 

Tab Size: From the drop-down list, select the tab size you want to use for displaying the Playlist, Copy 
from CD, Devices, and RioPort buttons at the top of your window.

Temp Directory: RioPort Audio Manager uses a directory to temporarily store files when it is performing 
various operations. By default, it uses the same Temp file Windows uses (c:\Windows\Temp). To change 
this directory, type the full path of the directory where you want to store temporary files. You can also click
the ellipsis button (…) to the right of this field to browse for a directory.

Reset all “Don’t Show This Again” flags: If you have checked the Don’t Show This Again box on any 
special dialog boxes (such as the Empty Play List dialog box) and want that dialog box to appear again, 
click this button. This resets all of the special dialog boxes.



Options dialog Storage tab
Use the Storage tab to set options for storing songs you create from a CD or when adding songs to the 
Playlist.

Song Directory: During the installation of RioPort Audio Manager, you specified the directory where you 
wanted recorded song files stored. To change this directory, type the full path of the directory where you 
want to store recorded song files. You can also click the ellipsis button (…) to the right of this field to 
browse for a directory.

Output File Format: From the drop-down list, choose the format you want RioPort Audio Manager to use 
when recording songs from your CDs to your hard drive. The file name for the recorded song will be in 
this format.

Replace space with underscore: When RioPort Audio Manager records songs from CDs, it can replace 
any spaces in the song file name with underscores. For example, it can change “my favorite song.mp3” 
to “my_favorite_song.mp3”. If you want to replace spaces with underscores, check this box. If not, clear 
the box.

Create directory for album: When you record from a CD, RioPort Audio Manager can create a 
subdirectory (in the Song Directory specified above) in which to store all songs recorded from that CD. If 
you want to create this subdirectory for each CD, check this box. If you would rather store all of the songs 
that you record from CD in your Song Directory without a separate subdirectory for each CD, clear this 
box.

Create album from song directory name: When songs are added to the database, RioPort Audio 
Manager can create an album record in your album database for each directory and subdirectory on your 
hard drive which contains music files. For example, if you added all of the music files from the directory c:\
party songs, an album record would be created called “party songs” and it would contain all of the songs 
that you added from that directory. If you want the software to do this, check this box. If not, clear the box.



Options dialog Read CD tab
Use the Read CD tab to specify settings to use when reading the contents of an audio CD.

Drive: From the drop-down list, select the letter of the CD drive which you want to read or record. RioPort 
Audio Manager automatically detects all of the CD drives installed on your computer.

CD Read Method: From the drop-down list, select the method you want to use to read CDs. Digital (VxD)
reads songs straight from your CD digitally. Digital (WinAspi) uses software to digitally read songs from 
your CD. Analog plays the song from the CD and records it using your sound card. The method that 
works best depends on your CD drive. If you are not sure which method to use, click the Configure it for 
me button and RioPort Audio Manager will select the best method for your CD drive.

Configure it for me: Click this button if you want RioPort Audio Manager to analyze your CD drive and 
select the CD Read Method for you. 

Record file as: From the drop-down list, select the file format you want to use when recording audio files 
from CD, such as Mpeg (MP3) or Microsoft Media Audio (WMA).

Bit Rate: From the drop-down list, select the bit rate at which you would like audio files to be recorded. 
The higher bit rates take up more hard drive space and provide better sound quality, while the lower bit 
rates require less hard drive space, but provide lower sound quality.



Options dialog CDDB tab
Use the CDDB tab to set options for using a CD database web site.

CD Database Site: From the drop-down list, select the CDDB Web site you would like to use to access 
CDDB information.

Update CDDB Site List: Click this button if you want to update the list of Web sites from which CDDB 
information may be downloaded.

Always get title from CDDB when CD is inserted: If you always want RioPort Audio Manager to 
connect to the Internet and download CD information from the CDDB Web site when you insert a new CD
in your drive, check this box. If you would rather be asked whether or not to connect to the Internet and 
download this information each time you insert a new CD, uncheck this box.

Email address: If you plan to submit information to the CDDB Web site, CDDB requires that you include 
your email address with your CD information submission. They will use this email address to contact you 
if there is a problem or question with the information you submit.

Goto CDDB Website: Click this button to open your Internet browser and navigate to the CDDB Web 
site.

Note: The CDDB is a database containing artist, disc title, track titles, and other information for digital 
audio compact discs. CDDB has become the de facto standard for Internet access of compact disc 
information. You can use RioPort Audio Manager to access this database via CDDB server hosts on the 
Internet. 



Options dialog Player tab
Use the Player tab to select the device you want to use to play music.

Music Player: From the drop-down list, select a music player you would like to use for song playback. 
You may use the RioPort Audio Manager Player or an external player like WinAmp.

Update Rate: From the drop-down list, select the rate at which you want the RioPort Audio Manager 
Player’s Spectrum Analyzer to update. The Spectrum Analyzer is the display beneath the counter on the 
Playlist window which provides a graphic representation of the song currently playing. If you are 
experiencing problems during playback (such as slow response from other applications or a “clipping” of 
the song as it is playing) due to strains on your computer’s processor, you may want to lower this rate, or 
turn it off completely by selecting None.



Options dialog Portable tab
Use the Portable tab to set options for working with a portable player.

Comm Port: From the drop-down list, select the communications port on your computer to which your 
portable player device is connected.

Transcode Bit Rate: RioPort Audio Manager can re-encode songs as they are transferred to your 
portable player device. This is especially useful when you would like to fit more songs on your portable 
device, and you are not as concerned about the sound quality. From the drop-down list, select the bit rate 
at which you would like song files to be re-encoded as they are transferred to your portable device. Keep 
in mind that song files can only be re-encoded at a lower bit rate. If you want to leave song files as they 
are when you transfer them to the portable device, select “None” from the drop-down list. 

Portable: From the drop-down list, select the portable player device to which you would like to transfer 
music files from RioPort Audio Manager. This list displays all of the portable devices which RioPort Audio 
Manager detects have been installed on this computer.



Options dialog Custom tab
Use the Custom tab to personalize the names of your six custom fields.

Custom 1-6: In this field, enter the name of the field as you want it to appear in the Edit Song and Edit 
Album dialog boxes.



Special Circumstances dialog boxes
The Special Circumstances dialog boxes appear to provide you with assistance in navigating and using 
RioPort Audio Manager. If you simply want to exit this dialog box and proceed on your own, press the 
Close button. If you do not ever want one of these dialog boxes to reappear in the future, put a check 
mark in the Don’t Show This Again box in the lower left corner. If you decide later that you would like to 
see the dialog box, under the appropriate circumstances, you can reset the Don’t Show This Again option
by selecting View and Options and pressing the Reset all ‘Don’t Show This Again flags’ button. Below are
descriptions of each of the Special Circumstances dialog boxes.

Empty Database

If you open the Playlist window and RioPort Audio Manager can’t find any music files in your song 
database, the Empty Database dialog box will appear. It offers several options for adding songs to your 
database. To record songs from an audio CD, insert that audio CD in your CD drive and press the Copy 
from CD button. Click the RioPort button to go to the Internet to search for, buy, and download music on 
the Web. If you already have song files on your hard drive and you would like RioPort Audio Manager to 
scan your whole hard drive and add all of the song files that it finds to your song database, press the 
Search Disk for Music button.

Registration Reminder

If you have not yet registered RioPort Audio Manager, the Registration Reminder dialog box will 
periodically appear to remind you to do so. If you would like to register the software, press the Register 
Now button. If you would rather register the software later, press the Register Later button.

Empty Playlist

If you open the Playlist window and your Song List does not contain any songs (but you do have songs in 
your song database), the Empty Playlist dialog box will appear. Click the Select Songs button to add 
individual songs to your Song List from your songs database. Press the Select Albums button to select an
album and add all of the songs from that album to your Song List.

No Audio CD

If you open the Copy from CD window and RioPort Audio Manager does not detect an audio CD in your 
CD drive, the No Audio CD dialog box will appear. If you would like to records some songs from an audio 
CD, insert that CD in your CD drive and press the Copy from CD button. Click the RioPort button to go to 
the Internet to search for, buy, and download music on the Web. 

Transfer Songs to Hardware Player

If you open the Devices window and you do not have any songs in your Transfer List, the Transfer Songs 
to Hardware Player dialog box will appear. Click the Select Songs button to add individual songs to your 
Transfer List from your songs database. Press the Select Albums button to select an album and add all of 
the songs from that album to your Transfer List.

Not Enough Room on Hardware Player

On the Devices window, if you are adding songs to your Transfer List and you select more songs than will 
fit on the available space on your portable player device, the Not Enough Room on Hardware Player 
dialog box will appear. It provides advice on fixing this situation. You may either untag some songs in your
Transfer List, or you may remove songs from the portable device. When you have either selected an 
amount of songs that will fit on the portable device, or have freed enough space on the portable device to 
fit all of the songs that you have tagged, the Usage bar will no longer show any amount in red. You may 
then press the Copy to Portable button to transfer the tagged songs to your portable device.



Review New Songs dialog box
Use this dialog box to review the new songs you’re adding to your database from your hard drive. You 
can mark all of the songs as reviewed, review individual songs, preview the songs, or close the window 
and review the songs later.

To preview the songs, use the Miniplayer controls under the Detail box. Click the Accept All button to 
accept all the songs in the Review Song List and their descriptions. Click a song and then click the 
Review/Edit button to review the selected song or edit its description. Click the Review Later button if you 
want to mark the songs as not reviewed and close this dialog box. The songs have already been added to
your database and their review status will not affect any other functions.



Review Song List
This list shows all the new songs you are adding to your database from your hard drive. For each song, 
the list shows the song title, artist, original album, and playing time (in minutes and seconds. When a 
song is highlighted, all of the information about that songs is displayed in the Detail box.

Click a column heading to sort the list by that item. For example, to sort the list by artist, click the Artist 
column heading.



Unlock Program dialog box
When you have received your Certificate Number from RioPort, use this dialog box to enter that 
Certificate Number to enable the full encoding capabilities of RioPort Audio Manager. Your Certificate 
Number is specific to your computer and will only unlock the program if it is installed on this computer.

Ticket Number: This field contains the ticket number which was transmitted to RioPort to receive your 
Certificate Number. You cannot edit the data in this field.

Certificate Number: Type the Certificate Number you received from RioPort in this field. You do not have 
to include dashes or spaces.

After you have entered your Certificate Number, click the Unlock button. If everything matches, you will 
receive a message which says, “The Certificate matches the Ticket. Your program now has unlimited 
recording.”    Simply press the OK button and proceed. If the number is typed incorrectly, or if there is a 
problem with the Certificate Number, you will receive a message which says, “The Certificate does NOT 
match the Ticket. Please retype the Certificate string.”    When you receive this message, press the OK 
button and verify that you have typed the Certificate Number exactly as it appears on the notice you 
received from RioPort. If you continue to receive this message and you have verified your Certificate 
Number, please contact RioPort technical support.



Small Player button
Click this button to transform RioPort Audio Manager into a Small Player which allows you to play the 
songs in your current song list.



Small Player
You can transform RioPort Audio Manager into a Small Player which allows you to play the songs in your 
current song list. If you like, you can customize the Small Player dialog box using WinAmp skins.

You can restore the Small Player to the full-size window in four ways:

· Click the Big Player button in the upper right corner of the Small Player window.

· Click the Rio graphic in the upper left corner of the Small Player window and then click Go Big.

· Click the PL button, located to the right of the volume and balance controls.

· Click the Open button, which is located between the Fwd and Shuffle buttons. 

The Small Player also supports the use of color schemes or “skins” which have been created in the format
used by Nullsoft’s WinAmp software.

· To change the skin, click the Rio graphic in the upper left corner of the Small Player window and then 
click Skins. Then navigate on your hard drive to the location of your WinAmp skin files, click one, and 
click the Open button. The Small Player should now be “wearing” the skin you selected. 

· To return to the original RioPort Audio Manager color scheme, click the graphic in the upper left 
corner and select Restore Skin. This restores the original RioPort Audio Manager color scheme.



Big Player button
Click this button to transform the Small Player to the large RioPort Audio Manager window.



Edit Category dialog box
Use this dialog box to add, rename, or delete categories. Click the Add button to add a new category. 
Highlight a category name and then click the Rename button to enter a new name for that category. 
Highlight a category name and then click the Delete button to delete that category.




